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Abstrak:
Perkembangan teknologi komputer demikian pesatnya, yang memiliki  fungsi awal sebagai alat bantu
dalam menyelesaikan persoalan dan masalah dalam segala bidang kemudian memasuki fungsi sebagai
penghibur.  Hal  ini  ditandai  dengan  banyak  produk-produk  yang  berbasis  komputer   dalam  dunia
hiburan. Salah satu dunia hiburan yang banyak diminati adalah kartun.

Penggunaan komputer untuk menghasilkan kartun yang professional sudah dilakukan diawali dengan
kartun-kartun  yang  dibuat  Hollywood  Amerika  Serikat  yang menggunakan komputer.  Di  Indonesia
sendiri bermunculan forum-forum yang membahas tentang animasi kartun ini dan beberapa perusahaan-
perusahaan yang memfokuskan diri di bidang animasi kartun.

Pembuatan  animasi  kartun  ini  jika ditekuni  akan  dapat  menciptakan  peluang-peluang  kerja  baru  di
Indonesia.  Dalam skripsi  ini  akan  digambarkan cara  membuat animasi  kartun dengan menggunakan
Macromedia Flash MX.
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1. Pendahuluan
Pada bab ini akan diuraikan cara mendesain kartun dengan menjabarkan proses produksi, pembangunan
cerita,  merencanakan  animasi,  mendesain  karakter,  membuat  model,   membuat  layout,  membuat
animasi, dan memasukkan suara

a.  Mendesain Kebutuhan Animasi Kartun
Animasi kartun yang akan didesain ini akan ditampilkan dalam bentuk web atau komputer. Pemilihan
media tampilnya kartun akan mempengaruhi dari bentuk desain kartun yang akan dibuat. Terdapat dua
media yang saat ini berpengaruh besar yakni media televisi dan komputer.

Pada media televisi, kendala yang dihadapi adalah setiap negara memiliki sistem televisi yang berbeda,
dan tidak ada standar umum yang ditetapkan bersama.  Kondisi ini menyebabkan media video yang
dihasilkan oleh setiap negara susah untuk ditransfer. Contohnya video tape yang dibuat Amerika tidak
dapat diputar di Korea ataupun Inggris. Ketidaknyamanan ini disebabkan kondisi politik yang ada dalam
negara  tersebut,  yang  bertujuan  untuk  menghindari  pertukaran  informasi  dengan  cepat  yang  akan
mempengaruhi  pandangan,  ide  maupun  gagasan  baru  dari  setiap  negara.  Tetapi  kondisi  ini  mulai
berubah pada saat internet sudah dapat menjangkau negara di seluruh dunia.

Digital  video  tidak  memiliki  batasan,  yang  didesain  dengan  kualitas  dan  ukuran  yang  mampu
menghantarkan informasi ke hadapan penggunanya. Format digital video ini dapat saja disimpan dalam
bentuk CD-ROM, DVD, ataupun dalam bentuk file yang dapat di download dari internet.

Beberapa sistem televisi yang digunakan umum di seluruh negara adalah:

a. NTSC System 

NTSC  (National  Television  System Committee)  merupakan  sistem milik  Amerika  Serikat
dengan lebar layar 525 baris, 30 fps, digunakan di negara Kanada, Greenland, Mexico, Kuba,
Jepang, Philipina, Puerto Rico dan beberapa negara di Amerika Selatan.  

b. PAL dan SECAM System

Banyak negara yang menggunakan kedua sistem ini yakni PAL (Phase Alternating Line) atau
SECAM (Sequential Color and Memory). Kedua sistem ini memiliki lebar layar 625 baris,
dengan penggunaan 25 fps. 

c. HDTV

HDTV (High Definition Television) adalah standar internasional baru untuk dunia televisi.
HDTV dapat digunakan dalam 1.125 baris.

b. Sinopsis
Animasi  kartun yang dibuat  ini  berjudul  “Wanita  Jagoan  Cun Lee” menceritakan aksi  dari  seorang
pendekar  wanita  yang menunjukkan  kehebatan ilmu beladirinya.  Pada  aksi  pertama Cun Lee (nama
tokoh kartunnya) melakukan tendangan maut,  dan kemudian secara beruntun dia mengeluarkan ilmu
tenaga  dalamnya  menggunakan  tangan  kirinya  disertai  dengan  efek  suara  ilmu  yang  telah
dikeluarkannya. 

c. Membuat Storyboard
Storyboard  adalah rancangan dasar  dalam menciptakan suatu animasi kartun. Bentuknya menyerupai
halaman komik. Halaman yang dibangun dalam storyboard ini akan memandu kartunis dan animator
dalam membuat gambar dan animasinya. Pada animasi kartun yang dibuat ini gambar yang dihasilkan
merupakan hasil scanning dari buku komik. Storyboard kartun ini:
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Gambar 1. Storyboard

d.  Membuat Latar Belakang

Penggunaan latar belakang dalam animasi kartun merupakan bagian penting dalam keberhasilan animasi
kartun itu sendiri yang memperkuat kesan yang ingin ditonjolkan. Pemilihan latar belakang harus tepat
pada tujuannya dan sesuai dengan waktunya (suasana yang ingin diciptakan). Latar belakang ini juga
jangan bersifat kaku yang selalu menampilkan latar belakang seperti kota, gunung, hutan  dan lainnya,
tetapi juga perlu ditambahkan efek-efek khusus yang memperkuat tokoh utama.

Pada animasi kartun yang akan dibuat ini, latar belakang yang ditampilkan nanti adalah wajah tokoh
yakni Cun Lee, yang ditampilkan dengan ukuran besar.  Tujuannya adalah untuk memperkuat tokoh
utama karena animasi kartun ini berdurasi singkat.
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2. Prinsip Dasar Animasi Karakter 
(sumber: animatorforum.org)(sumber: animatorforum.org)

Animasi karakter adalah teknik yang dibuat untuk menghidupkan peran-peran, menjadi suatu karakter
hidup  dan  manusiawi.  Untuk  menjadi  karakter  animator  yang  baik  diperlukan  perpaduan  berbagai
keahlian.  Untuk  menjadi  seorang  animator,  diperlukan  penguasaan  keahlian  di  bidang  acting,
sinematography,  dan  pemahaman  mengenai  proses  pembuatan  film.  Seorang  animator  juga  harus
mengerti  mengenai  proses  penceritaan  yang  baik,  akan  menarik  perhatian  penonton  sehingga
memancing reaksi penonton yang menyaksikan, baik tertawa, sedih maupun gembira. Dengan kata lain,
seorang animator harus bisa mengekpresikan emosi tertentu kepada penonton, bukan mempertontonkan
serangkaian gerak yang tidak berarti.

Untuk mampu menghasilkan karya yang baik diperlukan penguasaan terhadap 12 prinsip dasar animasi.
Prinsip  yang  berlaku  pada  animasi  2D  maupun  3D  (termasuk  paper dan  clay  animation)  adalah
rangkuman sifat-sifat gerak di alam, terutama gerak manusia. 10 Prinsip pertama dikenalkan pertama
kali oleh Frank Thomas & Ollie Johnston dalam bukunya, Illusion of Life, tahun 1981. Lebih jauh lagi
John  Lasseter,  yang  dikenal  sebagai  sutradara  film  Toys  Story,  menambahkan  menjadi  12  dalam
makalahnya di SIGGRAPH 1987, yang berjudul "Principles of Traditional Animation Applied To 3D
Computer Animation".  Pemahaman kedua belas prinsip tersebut adalah :

1. Pose dan gerakan antara (Pose-To-Pose Action and Inbetween) 

Pada animasi yang didesain di atas akan sulit jika langsung meng-copy semua gerakan pada tiap
frame. Agar mudah, animator membagi sekuens gerakan dalam 2 bagian, yaitu pose dan gerakan
antara (Pose-to-pose and Inbetween). Pose adalah gerakan paling ekstrim dari tiap gerakan yang ada
dan inbetween adalah gerakan antara suatu pose ke pose lainnya. Pada animasi 2D key animator
akan menggambar key pose. Lalu inbetweener melanjutkan dengan membuat gerakan antara satu
pose ke pose yang lainnya. Animator 3D biasanya melakukan setup karakter dan mengatur pose.
Inbetween dilakukan oleh komputer secara otomatis. 

    

Gambar 2. Pose dan Inbetween

Hasil dari animasi di atas: 
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Pose yang ada adalah : 

1. Kaki kiri berdiri bersiap melakukan tendangan

2. Kaki kiri melakukan tendangan keatas

Inbetween-nya adalah : Gerakan kaki kiri pada saat melakukan gerakan tendangan sampai melakukan
tendangan ke atas. 

2. Pengaturan waktu (Timing) 

Pengaturan waktu  merupakan "jiwa" dari suatu animasi. Dengan mengatur durasi gerakan, suatu
karakter bisa terlihat berbeda dari karakter yang lain. Meskipun posenya sama, tetapi dengan durasi
gerak berbeda,  karakter bisa terlihat berjalan santai (jarak antara key pose cukup jauh),  berjalan
biasa, atau terlihat tergesa-gesa berlari (jarak antara key pose lebih dekat). 

Pada  animasi  kaki  tendangan  di  atas  di  desain  untuk  tendangan  kaki  kiri,  pada  saat  kaki  kiri
menendang ke  atas  dibuat  pengaturan  waktu sebanyak 120  frame,  dan  kaki  kiri  turun  kembali
sebanyak 120 frame lagi.

3. Gerakan sekunder (Secondary Action)

Gerakan sekunder adalah gerakan yang terjadi akibat gerakan yang lain. Gerakan itu merupakan
gerakan  masih  suatu  kesatuan  sistem yang  tidak  terpisahkan  dari  gerakan  utama.  Pada  desain
animasi  di  atas,  dirancang pada  saat  melakukan  tendangan,  tangan  tangan  kiri  juga  melakukan
penyeimbangan dengan melakukan gerakan, pinggang tokoh juga akan ikut berputar dan badan akan
ikut condong ke belakang mengeikuti gerakan tendangan. Gerakan ini terjadi akibat gerakan utama,
yaitu tendangan kaki, yang terjadi akibat reaksi alamiah tubuh untuk tetap seimbang. Contoh lainnya
jika anjing yang sedang berlari dan tiba-tiba berhenti. Pada saat berhenti, telinganya yang panjang
tidak langsung berhenti, melainkan bergerak ke depan dan baru kemudian berhenti. Gerakan telinga
anjing tadi terjadi karena gerakan berhenti. Contoh lain bisa dilihat pada ekor binatang pada saat
berjalan, ekor tersebut tidak tinggal diam , melainkan juga bergerak seirama dengan gerakan badan
binatang tersebut.Untuk menciptakan gerakan sekunder menambah kesan gerak alami, gerakan ini
tidak boleh melebihi gerakan utama.

4. Akselerasi gerak (Ease In and Out)

Prinsip ini diilhami dari  hukum Newton yaitu setiap benda diam cenderung tetap diam, dan setiap
benda bergerak akan tetap bergerak, kecuali mengalami percepatan atau akselerasi. Dari suatu pose
yang diam ke sebuah gerakan akan terjadi percepatan, dan dari gerakan ke sebuah pose akan terjadi
perlambatan. Gerakan semua benda mirip dengan laju mobil. Saat bergerak mobil akan berakselerasi
terlebih  dahulu,  lalu  mobil  itu  bergerak  dengan  kecepatan  tetap.  Sebelum  berhenti  ia  akan
mengalami perlambatan atau akselerasi negatif dan akhirnya berhenti di satu titik. Contoh lainnya
adalah bola yang ditembakkan dengan kanon. Pada saat ditembakkan, ia melaju dengan kecepatan
tertinggi, lalu gaya gravitasi akan memperlambatnya dan ia akan berhenti pada ketinggian tertentu.
Gaya gravitasi akan menariknya kembali dan ia akan bergerak dengan akselerasi tertentu ke arah
bumi. Akhirnya bola itu akan mencapai titik terendah pada kecepatan tertinggi. Prinsip yang sama
berlaku pada animasi karakter. Pada gerakan menggelengkan kepala, animator akan menambahkan
"percepatan" pada awal gerak dan "perlambatan" pada akhir gerak. 

5. Antisipasi (anticipation)

Pada dasarnya semua gerakan akan terjadi dalam 3 bagian, bagian awal yang disebut antisipasi,
gerakan itu sendiri,  dan gerakan akhir yang disebut gerakan penutup (follow through). Pada saat
meloncat biasanya makhluk hidup akan menekuk ke dua kaki, membungkukkan badan dan menarik
ke dua tangan ke bawah, barulah meloncat. Gerakan pendahuluan inilah yang disebut antisipasi.
Demikian juga waktu duduk dan bangkit dari tempat duduk. Sebelumnya membungkukkan badan,
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menekan beban seluruh tubuh pada telapak kaki, dan melenting ke atas untuk bangkit.  Gerakan
antisipasi ini juga berlaku untuk semua gerakan. Pada film animasi 2D atau film karton, misalnya
Road runner,  tokoh kartun tersebut hilang dari layar dengan meninggalkan segumpal asap tebal.
Biasanya sebelum lari mereka memasang pose persiapan. Kaki di tarik menjauh dari arah lari, dan
tangan  merentang  bersiap-siap  lari  hilang.  Antisipasi  mengantarkan  pikiran  untuk  menyambut
gerakan berikutnya. Biasanya semakin cepat suatu gerakan, semakin lama waktu antisipasinya. 

6. Gerakan penutup dan perbedaan waktu gerak (Follow Through and Overlapping Action)

Prinsip ini didasari hukum kelembaman Newton yaitu setiap benda yang bergerak cenderung tetap
bergerak, bahkan setelah mendapat gaya yang menghentikannya. Jika sebuah mobil y ngebut dan
tiba-tiba berhenti, sebelum berhenti ia akan melaju melebihi titik hentinya dahulu, baru setelah itu
kembali  ke  titik  semula.  Sama  juga  jika  berlari  dan  tiba-tiba  berhenti.  Badan  akan  sedikit
"terlempar" ke depan, sebelum akhirnya kembali ke titik seimbang. Demikian pula pada saat tangan
memukul sesuatu. Tiba-tiba berhenti, dan tangan akan bergetar sedikit pada titik yang paling ektrim.
Ini yang disebut gerakan penutup (follow through). Tidak semua gerakan terjadi atau berhenti pada
saat yang bersamaan. Selalu ada perbedaan waktu antara langkah kaki dan ayunan tangan. Sering
gerakan-gerakan tersebut terasa bertindihan. Prinsip ini yang dikenal sebagai  overlapping action.
Pada saat melompat turun ke bawah,  pada saat kedua kaki  menginjak tanah dan tidak mungkin
kedua kaki  turun bersamaan.  Kedua tanganpun tidak akan langsung berhenti  berayun pada saat
bersamaan, melainkan cenderung terus berayun ke depan untuk mengimbangi tubuh agar kembali
stabil. Kedua lengan pun tetap tidak akan berhenti secara bersamaan. Setiap gerakan yang ada akan
terjadi  pada  waktu  yang  berbeda-beda.  Biasanya  gerakan  sekunder  akan  mengalami  perbedaan
waktu gerak (Overlapping action). Jika seekor binatang bergerak, ekornya akan ikut bergerak, tetapi
gerakan ekor tidak berhenti bersamaan dengan gerakan binatang, melainkan berhenti beberapa saat
lebih panjang. Inilah penerapan prinsip overlapping action. 

Pada animasi kartun yang dibuat setelah Cun Lee berhasil melakukan tendangan tangan kanannya
otomatis  juga  akan  bergerak,  begitu  juga  pada  saat  Cun  Lee  sudah  mengeluarkan  ilmu tenaga
dalamnya.  Pada  saat  gerakan  terakhir  penutup  celana  Cun  Lee  ikut  bergerak  setelah  Cun  Lee
melakukan semua kegiatannya. Gerakan ini yang disebut dengan gerakan lanjutan (followthrough)

.
 
Tidak semua gerakan terjadi secara bersamaan. Gerak alami terjadi secara susul menyusul (overlap).
Pada  desain  animasi  Cun  Lee  gerakan  tendangan  akan  diikuti  dengan  gerakan  tangan  yang
melakukan pukulan tenaga dalam yang menujukkan gerakan  yang terjadi  susul  menyusul antara
gerakan satu dengan lainnya.
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7. Gerak melengkung (Arcs) 

Pada  film  Stefen  Seagel  selalu  dapat  dilihat  keindahan  gerak  aksi  perkelahian.  Keindahan  ini
berasala dari bela diri Aikido. Aikido menyatakan bahwa semua gerakan di alam bersifat melingkar
atau melengkung. Perputaran planet yang berbentuk elips. Keindahan gerakan tari, atau pun gerakan
manusia  dan  hewan.  Prinsip  inilah  yang  diterapkan  pada  animasi.  Contoh  orang  yang  sedang
menggelengkan kepala . Pada saat kepala menggeleng dari kiri kanan, ia akan membuat gerakan
sedikit  melengkung  ke  arah  atas  atau  bawah  yang  membentuk  lingkaran.  Dengan  menerapkan
prinsip gerakan melengkung sebuah animasi tidak akan terlihat kaku seperti robot. 

Gambar 3. Gerakan melengkung

7. Dramatisasi gerakan (Exaggeration)

Dramatisasi gerakan adalah tindakan mempertegas apa yang sedang dilakukan. Para pemain  aktor
teater  akan  mendramatisasi  atau  melebih-lebihkan  aksi  mereka  agar  terlihat  jelas  oleh  para
penonton, apalagi penonton selalu melihat pertunjukan dari jarak jauh (long shot). Saat marah , sang
aktor  berkacak  pinggang,  menggerakkan  seluruh  badannya,  dan  menuding-nuding  lawannya.
Demikian  pula  saat  tertawa,  ia  berkacak pinggang,  menarik  bagian  atas  tubuhnya ke  belakang,
mengangkat kepalanya ke atas, membuka mulut selebar-lebarnya dan akhirnya mengeluarkan suara
tawa demikian kerasnya.  

8. Elastisitas (Squash and Stretch) 

Prinsip elastisitas dapat dilihat dalam kartun Coyote dalam animasi "Road Runner" yang senang
dengan aksi  kejar-kejaran.  Tetapi  Coyote  selalu  gagal  dan  terjatuh ke  jurang.  Sebelum jatuh ia
memandang  kamera,  sementara  kaki,  badan  dan  lehernya  memanjang  (strecthing)  ke  bawah.
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Akhirnya kepalanya hilang dari layar dengan meninggalkan segumpal asap. Contoh lainnya adalah
bola karet yang dilempar ke atas, akan "penyek" (squash) dulu sebelum memantul kembali ke atas. 

Kelenturan  menunjukkan  tingkah  rigiditas  suatu  objek.  Bola  karet  akan  mempunyai  derajat
kelenturan  yang  berbeda  dengan  bola  bowling.  Pada  objek  realistis,  prinsip  ini  terlihat  pada
kontraksi otot. Tekuk kedua lengan dan kencangkan otot, otot akan mengalami pembesaran. Hal
penting  yang  harus  dilakukan  adalah  setiap  benda  yang  mengalami  pelenturan  tetap  akan
mempertahankan  volumenya.  Jika  sebuah  karakter  berubah  volumenya,  realitas  yang  ada  akan
hilang.  Pada  animasi  prinsip  ini  tidak  diberlakukan,  melainkan  pada  bagian  tertentu  dari  suatu
benda.  Otot  biceps  misalnya  mengalami  pelenturan  yang  lebih  besar  pada  bagian  tengahnya
dibandingkan  bagian  tendon  atau  tepinya.  Meskipun  benda  rigid  atau  benda  realistis  (seperti
manusia) tampak tidak mengalami pelenturan, prinsip ini tetap saja digunakan. Pada saat melompat
ke bawah badan akan tertekuk sedikit, gerakan ini yang merupakan gerakan sekunder mirip dengan
peristiwa "penyek" yang terjadi pada bola karet yang dilempar ke lantai. 

9. Penempatan di bidang gambar (Staging) 

Selain  animasi  cara  menempatkan  karakter  dihadapan  kamera  mutlak  diperlukan.  Dengan
menempatkan  kamera  atau karakter  secara  tepat,  konsep yang diinginkan  dapat  terbaca dengan
mudah  oleh  penonton.  Prinsip  yang  paling  penting  adalah  prinsip  sinematography  dan  prinsip
silluet.  Dengan  penempatan  kamera  yang  rendah,  sebuah  karakter  akan  terlihat  besar  dan
menakutkan. Demikian juga dengan penempatan kamera yang tinggi, karakter akan terlihat kecil
atau terlihat  bingung.  Penempatan  kamera dengan arah miring  (rolling)  akan membuat  gerakan
terlihat dinamis. Penempatan secara simetris akan membuat karakter terlihat formal dan berwibawa,
penempatan arah gerak secara diagonal juga akan membuat adegan terlihat dinamis. Melihat Siluet
karakter (hanya pada bagian foreground vs background) juga memberikan ketegasan pose sebuah
karakter. Jika siluet karakter terlihat ambigu alias tidak jelas. maka akan sulit bagi penonton untuk
mencerna aksi yang dilakukan karakter.  Dengan kata  lain,  seorang animator  juga membutuhkan
kemahiran  dari  berbagai  bidang.  Sinematography,  penyutradaraan,  akting,  editing  dan  juga
compositing sangat penting untuk membantu seorang animator menyelesaikan karyanya. 

10. Daya tarik karakter (appeal) 

Setiap karakter dalam animasi haruslah mempunyai daya tarik yang unik, yang membedakannya
dengan karakter yang lain.  Bisa  saja  suatu  karakter  terlihat  unik  dari  design,  atau dari  caranya
menunjukkan ekpresi pribadinya, seperti yang dimiliki oleh Donal Bebek dan Tazmanian Devil. Jim
Carey misalnya, mempunyai daya tarik yang berbeda dengan Harrison Ford. Daya tarik Jim Carrey
adalah  tingkah  lakunya  yang demikian  hiperbolik.  Sean  Connery mempunyai  daya  tarik  dalam
kedewasaan  kepribadiannya.  Daya  tarik  karakter  bukan  saja  terlihat  pada  penampilannya  (rupa
karakter,  desain  pakaiannya,  atau  penampilan aksesorinya) melainkan terefleksikan pada seluruh
gerak-gerik,  tingkah  laku  dan  sikapnya.  Daya  tarik  memungkinkan  penonton  untuk  menaruh
perhatian khusus kepada karakter yang ditampilkan.   

11. Penjiwaan peran (personality) 

Kemampuan  akting  adalah  satu  hal  yang  harus  dimiliki  setiap  karakter  animator.  Akting
memungkinkan  animator  menterjemahkan  tingkah  laku  dan  daya  tarik  karakter  secara  tepat,
sehingga penonton merasakan apa yang dimaui oleh sang animator, bahkan tanpa dialog sekalipun.
Cara paling mudah menghayati suatu peran adalah dengan membayangkan karakter sebagai seorang
aktor. Animator yang baik adalah animator yang mampu menggerakkan seluruh anggota tubuhnya
dan menterjemahkannya ke dalam suatu karya animasi. 
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Tanpa penjiwaan sebuah karakter akan terlihat datar, kaku dan tidak manusiawi. Penjiwaan peran
ini adalah "roh" dari setiap karakter. Dengan penjiwaan setiap karakter akan terlihat berbeda dari
lainnya, tampak lebih hidup dan lebih "berjiwa". Dibutuhkan pengetahuan mengenai latar belakang
dari  setiap karakter,  tingkah laku,  caranya berkomunikasi  dan bereaksi  terhadap lingkungannya.
Cara  paling  mudah  menghayati  karakter  adalah  dengan  menghayalkan  aktor  tertentu  dan
menterjemahkan sifat aktor tersebut ke dalam karakter animasi yang dibuat.  

3.  Mempersiapkan  Animasi Kartun
a. Kebutuhan Software

Dalam mendesain animasi kartun ini diperlukan beberapa software yang harus tersedia di  komputer,
yaitu:

1. Sistem Operasi yang digunakan dapat salah satu yaitu Windows 98, Windows NT, Windows 2000
ataupun Windows XP.

2. Software  menscanner  gambar  biasanya  disertakan  pada  saat  pembelian  scanner  seperti  Adobe
Photoshop, Photostudio dan lainnya.

3. Software mengolah animasi kartun yaitu dengan Macromedia Flash MX.

4. Untuk  merekam suara  dapat  digunakan software  yang telah  disediakan Windows yakni  “Sound
Recorder”. 

b. Proses Memperoleh Objek Gambar

Berdasarkan storyboard yang telah dibuat, selanjutnya membuat gambar kartun untuk dibuat animasi
yang diinginkan. Dalam tulisan ini sumber gambar diambil dari buku,”How to Draw & Create Manga”
karya Tatsu Maki, pada halaman 106. Gambar yang sudah ada di scanner dan didapat hasil  sebagai
berikut:
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Gambar 4. Hasil Scanner Gambar Cun Lee dari buku “How to Draw & Create Manga”

c.  Penggunaan Macromedia Flash MX

Macromedia Flash MX adalah program grafis animasi standar professional untuk menghasilkan halaman
web yang menarik.  Movie Flash terdiri  atas  grafik,  teks,  animasi  dan aplikasi,  yang mengutamakan
grafik berbasis vektor. Flash memiliki akses lebih cepat dan akan terlihat halus pada skala resolusi layar
besar atau kecil, selain itu juga mempunyai kemampuan untuk mengimpor video, gambar dan suara dan
aplikasi.

Macromedia  Flash  MX  juga  bisa  memasukkan  unsur  interaktif  dalam  movienya  menggunakan
Actionscript (suatu bahasa pemrograman berorientasi objek), yang pengguna bisa berinteraksi dengan
movie, menggunakan keyboard atau mouse untuk berpindah ke bagian-bagian yang berbeda dari sebuah
movie, mengontrol movie, memindahkan objek-objek, memasukkan informasi melalui form dan operasi-
operasi lainnya.

Area Kerja Flash MX

Area gambar di Flash MX terdiri atas enam bagian, yaitu Menu, Stage, Timeline, Toolbox, Panels, dan
Properties.

•  Menu, berisi kumpulan instruksi atau perintah-perintah yang digunakan dalam Flash. Misalnya,
klik menu File, Save berfungsi untuk menyimpan dokumen.

• Stage adalah dokumen atau layar yang akan digunakan untuk meletakkan objek-objek dalam Flash.

• Timeline berisi frame-frame yang berfungsi untuk mengkontrol objek yang akan dianimasikan.

• Toolbox, berisi tool-tool yang berfungsi untuk membuat, menggambar, memilih dan memanipulasi
objek atau isi yang terdapat di layar (stage) dan timeline.

Toolbox dibagi menjadi empat bagian, yaitu Tools, View, Colors dan Options.

Beberapa tool mempunyai option-option.  Misalnya, klik  Arrow tool,  akan muncul pada bagian
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Options: Snap to Object, smooth dan straighten.

• Panels,  berisi  kontrol  fungsi  yang  dipakai  dalam Flash,  yang  berfungsi  untuk  mengganti  dan
memodifikasi berbagai atribut dan objek atau animasi secara cepat dan mudah.

• Properties, fungsinya sama dengan Panels, hanya saja Properties merupakan penggabungan atau
penyederhanaan  dari  panel.  Jadi,  dapat  lebih  mempercepat  dalam mengganti  dan  memodifikasi
berbagai atribut dan objek, animasi, frame dan komponen secara langsung.

4. Proses Pembuatan Animasi Kartun 
a. Membuat Gambar Utama

Gambar  Cun  Lee  yang  sudah  dibuat  akan  dimasukkan  ke  dalam Flash  MX,  kemudian  dilakukan
pemisahan  terhadap  bagian-bagian  tubuh  yang  akan  melakukan  pergerakan-pergerakan  yaitu  pada
bagian kepala, badan, tangan, kaki dan bagian lainnya. Untuk membuat pemisahan di atas, dilakukan
dengan memilih menu menu symbol.

1. Buat symbol di Flash MX, Insert >New Symbol

Gambar 6. Menu Insert Symbol

2. Copykan hasil scanner ke dalam scene, lalu lakukan Break Apart 2 kali (Modify > break a part).
Lakukan pemisahan bagian-bagian tubuh.

Gambar 7. Pemisahan gambar untuk animasi
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Kemudian dilakukan juga pemisahan kepala, untuk membuat efek berbicara dipisahkan juga bibir atas
dan bibir bawah dari gambar wajah Cun Lee.

Gambar 8. Pemisahan bagian kepala

Setelah selesai memisahkan bagian-bagian tubuh lakukan penyatuan kembali pada setiap layer dengan
memilih Modify > Group (Ctrl+G).

b. Membuat Animasi pada Key Frame

Untuk  membuat  animasi  pada  bagian-bagian  tubuh  yang  sudah  dipisahkan  menggunakan  perintah
“Create Motion Tween” pada keyframe 30.

- Key Frame 1 - 30

Semua bagian tubuh diatur sehingga menyerupai gambar di bawah ini:

Gambar 9. Animasi Cun Lee pada keyframe1         Gambar 10. Animasi pada keyframe 30
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- Keyframe 60

Cun Lee bersiap melakukan tendangan dengan mengambil ancang-ancang dengan memiringkan badan
dan menaikkan kaki kirinya.

Gambar 11. Keyframe 60 Cun Lee bersiap melakukan tendangan

- Key Frame 61

Cun Lee mengeluarkan suara sambil  melakukan tendangan.

- Key Frame 62-64

Lutut dan telapak kaki bergerak bersama melakukan tendangan. Pada keyframe 62 lutut naik keatas dan
keyframe 64 lutut kembali lagi kebawah. Dan dibarengi dengan suara (gerakan mulut).

- Key Frame 69 - 142 

Mengerakkan mulut hingga kelihatan dia berbicara “  Halo nama saya Cun Lee Saya adalah pendekar
kebenaran dan keadilan senang berjumpa dengan kamu “.

- Key Frame 59-71

Pada key frame ini gerakan tangan maju.

- Key Frame 71-75

Gerakan tangan miring ke bawah.

- Key frame 75 –80

Gerakan tangan miring ke atas.

- Key frame 80-100 

Gerakan tangan mundur.

 - Key Frame 100-105

Gerakan tangan maju.

Menggerakan tangan seperti gambar dibawah ini:
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Gambar 12. Gerakan tangan

- Key frame 120 

Pada key frame ini semua layer diberikan key.

- Keyframe 163

Semua bagian tubuh diatur membentuk animasi sehingga menyerupai gambar di bawah ini:

Gambar 13. Gerakan dari 120-163.
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- Key Frame 190

Pada key frame ini Cun Lee menurunkan kaki, seperti gambar dibawah ini.

 

   Gambar 14. Key Frame 163 Gambar 15. Key Frame 190

- Key Frame 190 – 230 

Pada key frame ini Cun Lee mengeluarkan suara dan seolah-olah berkata “  Hai kalian semua jangan
coba-coba mengganggu aku ya”

c.  Efek Tendangan

Pada saat Cun Lee melakukan tendangan, ada efek tendangan berupa gambar pergerakan udara akibat
tenaga  yang dikeluarkan oleh tendangan.  Untuk  membuat efek ini  dibuat  sebuah symbol baru yaitu
Movie klip berupa garis setengah lingkaran. 

Gambar 16. Efek Tendangan

Pada symbol yang baru di frame 25 diberikan efek “Create Motion Tween” pada masing-masing key
frame klik key frame 25 perbesar gambar efek, kemudian warna efek tendangan diubah warnanya (menu
Properties menjadi Alpha 0 %). 

Untuk membuat efek bekerja pada gambar utama, masuk ke simbol kartun dan membuat  layer baru dan
meletakannya paling  atas, dan beri nama “efek tendangan”, pada frame 61 dibuatkan keyframe. Buka
panel library kemudian seret simbol efek tendangan, letakan efek tendangan tersebut tepat pada ujung
telapak kaki.
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Gambar 17. Efek tendangan

e. Efek Ilmu

Efek ilmu akan ditampilkan ketika Cun Lee selesai melakukan tendangan, dan Cun Lee mengeluarkan
ilmunya. Caranya dengan membuat Simbol baru (New Simbol Movie klip ) dan gambar dari efek ilmu
seperti di bawah ini.

Gambar 18. Efek ilmu

Untuk membuat efek ilmu ini bekerja pada key frame pada frame 10 dan 20 buat   “Create  Motion
Tween”. Pada key frame 10 perbesar gambar efek ilmu untuk membuat kesan efek ilmu terus membesar.

Untuk memasukkan ke dalam gambar utama, dibuat sebuah layer baru di atas layer efek tendangan dan
memberi nama “efek ilmu”. Pada layer efek ilmu buat keyframe pada frame 80 dan seret simbol “efek
ilmu”  melalui  panel  Library.  Kemudian  pada  frame  80  buat  “Create  Motion  Tween”,  lalu  dibuat
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keyframe pada frame  95, 105, dan 142. Pada frame 105 perbesaar “efek ilmu” Modify > Transform >
Scale and Rotate (Ctrl + Alt + S) ubah menjadi 200 %. Klik key frame 142 perbesar efek ilmu menjadi
400 %, dan seret hingga keluar dari Scene.

f.   Memasukkan Suara

Dalam sebuah animasi kartun unsur penting lainnya adalah suara. Suara memberi pengaruh yang sangat
besar terhadap desain kartun yang dibuat, yang mewakili karakter dan suasana. Cara memperoleh suara
dapat dilakukan dengan cara merekam suara atau mencari suara-suara latar belakang. 

Untuk menyimpan, mengedit suara diperlukan beberapa komponen hardware tambahan yakni:

1. Mikropon : untuk memasukkan suara.

2. Mic Pre-amplifier : Untuk memperhalus suara yang akan disimpan.

3. Speaker : untuk menghasilkan/mengeluarkan suara dari komputer.

4. Kartu Suara : untuk mengubah signal analog ke signal digital.

Gambar 19. Kebutuhan perangkat tambahan untuk merekam suara

Untuk animasi kartun Cun Lee, dalam symbol utama (kartun) dibuat sebuah layer baru di atas layer
“efek ilmu” dan diberi nama “suara”. Pada frame 60, 80 dibuat key frame, masuk ke menu Window >
Common Libraries > Sound dan dimasukkan suara yang cocok dengan efek tendangan dan masukkan
ke dalam stage. Pada key frame 80  lakukan impor suara dengan melakukan file > Import > dan dipilih
suara yang cocok dengan efek ilmu tersebut.

Gambar 4.17  Efek suara pada frame
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5.   Mempublish Animasi Kartun
Flash memiliki program publishing yang diberi  nama “Flash Player” yang dapat langsung diaktifkan
dengan menekan “Ctrl+Enter”.  File flash disimpan dalam bentuk file berekstensi FLA dan hasil dari
publishingnya file akan berekstensi SWF. 

Proses publishing di dalam Flash akan menghasilkan berbagai bentuk file yang dapat dimainkan atau
dijalankan oleh beberapa program aplikasi. Beberapa jenis file yang dapat dihasilkan dengan publish
adalah:

1. Flash Movie.

2. Format image seperti GIF, JPG dan PNG.

3. Quick time.

4. HTML.

5. File EXE.

Untuk mempublishnya digunakan langkah sebagai berikut:

1. Mengatur setting publish dengan klik File > Publish Setting.

2. Setelah dilakukan pengaturan pilihan klik File > Publish.
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